
 

OL-29355-01
C H A P T E R 12

Using Cisco PathTracer to Diagnose Problems

Cisco PathTracer enables you to view a network path between two network objects. The following topics 
describe Cisco PathTracer and how to use it: 

• User Roles Required to Work with Cisco PathTracer, page 12-1

• Cisco PathTracer Overview, page 12-2

• Launching Path Tracer, page 12-3

• Viewing Path Traces in Cisco PathTracer, page 12-14

• Viewing Path Trace Details, page 12-20

• Saving and Opening Cisco PathTracer Map Files, page 12-26

• Saving Cisco PathTracer Counter Values, page 12-26

• Rerunning a Path and Comparing Results, page 12-27

• Viewing Q-in-Q Path Information, page 12-27

• Viewing L2TP Path Information, page 12-28

• Using Cisco PathTracer in MPLS Networks, page 12-29

User Roles Required to Work with Cisco PathTracer
This topic identifies the roles that are required to work with Cisco PathTracer. Cisco Prime Network 
(Prime Network) determines whether you are authorized to perform a task as follows: 

• For GUI-based tasks (tasks that do not affect elements), authorization is based on the default 
permission that is assigned to your user account. 

• For element-based tasks (tasks that do affect elements), authorization is based on the default 
permission that is assigned to your account. That is, whether the element is in one of your assigned 
scopes and whether you meet the minimum security level for that scope. 

For more information on user authorization, see the Cisco Prime Network 3.10 Administrator Guide.

The following tables identify the tasks that you can perform:

• Table 12-1 identifies the tasks that you can perform if a selected element is not in one of your 
assigned scopes. 

• Table 12-2 identifies the tasks that you can perform if a selected element is in one of your assigned 
scopes. 
12-1
Cisco Prime Network 3.11 User Guide

http://www.cisco.com/en/US/products/ps11879/prod_maintenance_guides_list.html


 

Chapter 12      Using Cisco PathTracer to Diagnose Problems
  Cisco PathTracer Overview
By default, users with the Administrator role have access to all managed elements. To change the 
Administrator user scope, see the topic on device scopes in the Cisco Prime Network 3.10 Administrator 
Guide.

Cisco PathTracer Overview
Cisco PathTracer enables you to launch end-to-end route traces and view related performance 
information for Layer 1, Layer 2, and Layer 3 traffic. Upon receiving a path's start and endpoint, 
Cisco PathTracer visually traces the route through the network. For example, in an ATM network 
environment, Cisco PathTracer identifies all information regarding the connection of a subscriber to a 
provider, including all ATM PVCs, ATM switching tables, ATM class of service (CoS) definitions, 
IP-related information, and so on. 

You can also use Cisco PathTracer to: 

• Trace paths using IPv4, IPv6, or both IPv4 and IPv6 addresses for the source and destination.

• Trace a hypothetical Ethernet frame from a VLAN interface to a specified MAC address.

• Trace a hypothetical Ethernet frame from an Ethernet interface to a specified MAC address within 
a specific VLAN identifier.

Table 12-1 Default Permission/Security Level Required for Working with Cisco PathTracer - 

Element Not in User’s Scope

Task Viewer Operator OperatorPlus Configurator Administrator

Launch a path trace — — — — X

View path information — — — — X

Save Cisco PathTracer 
map files

— — — — X

Save Cisco PathTracer 
counter values

— — — — X

Rerun a path and 
compare results

— — — — X

Table 12-2 Default Permission/Security Level Required for Working with Cisco PathTracer - 

Element in User’s Scope

Task Viewer Operator OperatorPlus Configurator Administrator

Launch a path trace — X X X X

View path information — X X X X

Save Cisco PathTracer 
map files

— X X X X

Save Cisco PathTracer 
counter values

— X X X X

Rerun a path and 
compare results 

— X X X X
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In MPLS and Carrier Ethernet environments, Cisco PathTracer can trace paths across: 

• Carrier Supporting Carrier (CSC) configurations—A path trace along a CSC flow follows the path 
from the customer CE through the customer carrier VPN, across the customer backbone carrier 
VPN, back to the customer carrier VPN, and to the destination CE.

• VLANs—A path trace across VLANs follows the path based on the forwarding table, which means 
that the trace follows ports in the Forwarding STP state.

• Q-in-Q—A path trace across Q-in-Q creates a single path trace (if the MAC address is learned) or a 
multiple-path (multipath) trace if the MAC address is not in the forwarding table. If the VLAN 
bridge has not learned a given MAC address, the bridge floods the Ethernet frame to the confines of 
a given VLAN or switching entity and across those ports that allow the given VLAN identifier. A 
MAC/VLAN path trace can be conducted from a customer edge (CE) VLAN interface across a 
service provider (SP) VLAN; that is, across Q-in-Q configurations with the CE-VLAN identifier as 
the inner VLAN identifier and Cisco PathTracer detecting the outer SP-VLAN identifier that 
encapsulates the CE-VLAN.

• Pseudowires (also known as EoMPLS)—A MAC/VLAN path trace can be conducted from a VLAN 
interface across a VLAN attachment to a pseudowire.

• VLAN-VPLS-VLAN configurations—A multiple-point MAC/VLAN path trace can be conducted 
on CE-VLANs across a service provider VPLS transport from a VLAN interface that attaches to the 
VPLS.

In addition, Cisco PathTracer can trace a path: 

• If the destination MAC address is not reachable—If Cisco PathTracer cannot complete a 
MAC/VLAN path trace to a specified destination MAC address across an MPLS core, VPLS, or 
H-VPLS, then Cisco PathTracer displays the portion of the path that Cisco PathTracer can trace 
toward the destination MAC address.

• That contains a simulated Ethernet frame—Cisco PathTracer can trace a simulated Ethernet frame 
from a VLAN port, across a VLAN (VLAN-based flow domain fragment), VPLS (VPLS-based flow 
domain fragment), and VLAN, for an end-to-end MAC address trace.

Prime Network derives the various paths on the network from its up-to-date knowledge of the network. 
After a user selects a source and destination, Cisco PathTracer finds and retrieves the path of a specified 
service, and displays the path in the Cisco PathTracer window. The retrieved information contains 
network elements in the path, including all properties at Layer 1, Layer 2, and Layer 3, plus alarm 
information, counters, and more, all of which is available via Cisco PathTracer.

Launching Path Tracer 
Cisco PathTracer can be launched from a bridge, switching entity, Ethernet interface, Ethernet flow 
point, VLAN interface, ATM VC, DLCI, or IP interface entry point. Ethernet flow points can be starting 
points whether they are associated with an interface, bridge, or LAG. 

The virtual route is found according to the cross connect table of each ATM switch or Frame Relay 
device. The IP routing and path-finding process is enabled according to the VRF tables of each router, 
and the Ethernet-simulated path is found according to the various Layer 2 forwarding tables, such as 
bridges or VSIs. 
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To view a specific path, you must specify an initial point and a destination, such as an IP or MAC 
address. If you specify VC or DLCI information, which ends in a router, Cisco PathTracer finds the next 
hop according to the destination IP address. If you do not specify a destination IP or MAC address, 
Cisco PathTracer uses the default gateway in the router. Any business tags that are associated with the 
physical or logical entities are also displayed. 

Note A path can also be launched if a business tag attached to an endpoint that can be used as the starting 
point.

Path Traces and Blocked Ports

The following conditions apply for blocked ports: 

• You can launch a path trace from a blocked port. This action is equivalent to launching a path trace 
from a bridge.

• You can specify a blocked port as a destination. 

• If Cisco PathTracer encounters a blocked port in its path to the destination, the path trace stops. Path 
traces do not traverse blocked ports. 

Table 12-3 identifies the available path trace launching points and their locations within Cisco Prime 
Network Vision. Cisco PathTracer is available in each location as a right-click menu option. 

Cisco PathTracer Right-Click Menu Options
Cisco PathTracer is launched by using right-click menu options. Table 12-3 identifies the launching 
points for the different types of elements. 

Table 12-3 Cisco PathTracer Right-Click Menu Options

Element Location

Affected Parties • Inventory window

• Ticket Properties window (Affected Parties tab)

Bridge Inventory window

Business tag The path can be found using a business tag, which is attached to the 
VPI/VCI, or using an IP interface by entering its key. The path can 
then be opened from the Find Business Tag dialog box.

Ethernet flow point • Map view or navigation pane

• Inventory window

IP interface • Inventory window

• Affected entry

Layer 2 MPLS tunnel Inventory window

MPLS-TE tunnel Inventory window

MPLS-TP tunnel endpoint • Map view or navigation pane

• Inventory window

Port Inventory window
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Starting a Path Trace
You can start a path trace in the following ways:

• From the Map View, page 12-5

• From Logical or Physical Inventory, page 12-7

From the Map View

To start a path trace from the map view:

Step 1 In a Cisco Prime Network Vision map, start the path trace in one of the following ways:

• For a VLAN:

a. In the navigation pane or map pane, select the required network VLAN.

b. Double-click the VLAN to view the VLAN entities. 

c. Right-click the required item and choose PathTracer > From Here to Destination or 
PathTracer > Start Here.

• For a VPN: 

a. In the navigation pane or map pane, select the required network VPN. 

b. Double-click the VPN to view the VPN entities.

c. Right-click the site and choose PathTracer > From Here to Destination or PathTracer > Start 
Here.

• For an Ethernet flow point:

a. Choose Network Inventory > Ethernet Flow Domains.

b. In the Ethernet Flow Domain List Properties window, double-click the required domain. 

c. In the Ethernet Flow Domain Properties window, right-click the required element and choose 
PathTracer > From Here to Destination or PathTracer > Start Here.

Pseudowire endpoint • Map view or navigation pane

• Inventory window

Site Map view

Switching entity Map view

Virtual connection Inventory window:

• Cross Connect window

• VC Table window

VLAN • Navigation pane

• Map view

Table 12-3 Cisco PathTracer Right-Click Menu Options (continued)

Element Location
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The next step depends on your choice in Step 1: 

• If you choose PathTracer > From Here to Destination, the Path Information dialog box is 
displayed (Figure 12-1). Continue with Step 2. 

• If you choose PathTracer > Start Here, continue with Step 3. 

Figure 12-1 Path Information Dialog Box 

Step 2 To specify a destination: 

a. In the Path Information dialog box, enter the required information, as described in Table 12-4. 

Depending on the launch point, the Path Information dialog box might not contain all of the fields 
in Table 12-4. 

b. Click OK. 

Step 3 If you choose Start Here, navigate to the destination interface, port, or bridge, right-click it, and choose 
End Here.

The Cisco PathTracer window is displayed showing the path or paths that were found. 

Step 4 To view additional details regarding the path traces, select one or more paths in the paths pane. 

Table 12-4 Cisco PathTracer Path Information Dialog Box

Field Description

Destination IP Select this option to specify an IP address as the destination. Enter 
either an IPv4 or IPv6 address. 

Destination MAC Select this option to specify a MAC address as the destination. Enter 
the MAC address. 

VLAN ID Enter the required VLAN identifier. You must enter an IP address or 
a MAC address to use this option.

Inner VLAN ID Enter the required inner VLAN identifier. 

Stop trace after Check this check box to limit the number of hops that 
Cisco PathTracer makes in its attempt to reach the destination. 
Enter the maximum number of hops that you want to allow in the 
hops field. 
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Step 5 In the toolbar, click Cisco PathTracer. 

• If you select one or more paths in the paths pane, each selected path is displayed in its own window 
with the Layer 1, Layer 2, Layer 3, and Business Tag tabs.

• If you select nothing in the Paths pane, each path found is displayed in its own window with the 
Layer 1, Layer 2, Layer 3, and Business Tag tabs.

For more information about the end-to-end path and networking layer details, see Viewing Path Trace 
Details, page 12-20.

From Logical or Physical Inventory

To start a path trace from logical or physical inventory: 

Step 1 Open the inventory window for the required device. 

Step 2 Select one of the following launch points in logical or physical inventory: 

• IP interface

• MPLS-TP tunnel endpoint

• Port

• Pseudowire endpoint

• VLAN bridge

Step 3 Right-click the selected item and choose one of the following: 

• PathTracer > From Here to Destination—If you choose this option, continue with Step 2 in From 
the Map View, page 12-5. 

Note If you select an IP interface as the launch point, the right-click menu displays IPv4 and IPv6 
options. These options are enabled or dimmed, depending on whether the IP interface has an 
IPv4 IP address, an IPv6 address, or both IPv4 and IPv6 addresses. For an example, see 
Figure 12-3.

• PathTracer > Start Here—If you choose this option, continue with Step 3 in From the Map View, 
page 12-5. 

Examples of Launching Cisco PathTracer 
The following topics provide examples for launching Cisco PathTracer from different locations in 
Cisco Prime Network Vision: 

• Using an Ethernet Flow Point, page 12-8

• Using an IP Interface, page 12-9

• Using a VLAN Bridge, page 12-10

• Using an Ethernet Port, page 12-12
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• Using a Pseudowire, page 12-12

• Using an MPLS-TP Tunnel Endpoint, page 12-13

Using an Ethernet Flow Point

A network VLAN is required for you to start a path trace using an Ethernet flow point. 

To launch a path trace from an Ethernet flow point: 

Step 1 In the Cisco Prime Network Vision navigation pane or map pane, expand the required network VLAN. 

Step 2 In the VLAN, right-click the required Ethernet flow point and choose PathTracer > From Here to 
Destination. The Path Information dialog box is displayed as shown in Figure 12-2. 

Figure 12-2 Ethernet Flow Point Path Trace Launch Point

Step 3 Specify the destination using the information in Table 12-4. 

Step 4 To limit the number of hops for the path trace, check the Stop trace after check box, and enter the 
maximum number of hops for the path trace.

Step 5 Click OK. The Cisco PathTracer window is displayed with the resulting path trace.
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Using an IP Interface

Both IPv4 and IPv6 addresses are supported as valid path trace sources and destinations as illustrated in 
the following procedure.

To launch a path trace from an IP interface: 

Step 1 In logical inventory, right-click the required IP interface (Logical Inventory > Routing 
Entities > Routing Entity > ip-interface).

The right-click menu displays IPv4 and IPv6 options. These options are enabled or dimmed, depending 
on whether the IP interface has an IPv4 address, an IPv6 address, or both IPv4 and IPv6 addresses. See 
Figure 12-3. 

Figure 12-3 IP Interface Path Trace Launch Point - Right-Click Menu

Step 2 Choose PathTracer > From Here to Destination. 

The Path Information dialog box is displayed as shown in Figure 12-4.
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Figure 12-4 IP Interface Path Trace Launch Point - Path Information Dialog Box

Step 3 In the Destination IP field, enter the IPv4 or IPv6 address. 

Step 4 To limit the number of hops for the path trace, check the Stop trace after check box, and enter the 
maximum number of hops for the path trace.

Step 5 Click OK. The Cisco PathTracer window appears, displaying the resulting path trace.

Using a VLAN Bridge

You can launch path traces from VLAN bridges. Additionally, MAC addresses in the VLAN bridge 
forwarding table can be path trace destinations. 

To launch a path trace from a VLAN bridge:

Step 1 In logical inventory, right-click the required bridge (Logical Inventory > Bridges > bridge) and choose 
one of the following options as shown in Figure 12-5: 

• PathTracer > From Here to Destination 

• PathTracer > Start Here 
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Figure 12-5 VLAN Bridge Path Trace Launch Point

Step 2 If you choose From Here to Destination in Step 1, the Path Information dialog box is displayed. 
Specify the required destination using the information in Table 12-4.

Step 3 If you choose Start Here, navigate to the destination, right-click it, and choose End Here. Destination 
options include: 

• IP interface—Logical Inventory > Routing Entities > Routing Entity > IP-interface

• Bridge—Logical Inventory > Bridges > bridge

• MAC address—Logical Inventory > Bridges > bridge > Bridge Table > MAC-address 

• Ethernet port—Physical Inventory > chassis > slot > port 

When a destination is selected, the system extracts the relevant IP address from this point and uses it as 
the destination.

The Cisco PathTracer window is displayed with the resulting path trace.
12-11
Cisco Prime Network 3.11 User Guide

OL-29355-01



 

Chapter 12      Using Cisco PathTracer to Diagnose Problems
  Launching Path Tracer
Using an Ethernet Port

To launch a path trace from an Ethernet port: 

Step 1 In physical inventory, right-click the required port (Physical 
Inventory > Chassis > slot > subslot > port) and choose one of the following options as shown in 
Figure 12-6:

• PathTracer > From Here to Destination 

• PathTracer > Start Here 

Figure 12-6 Ethernet Port Path Trace Launch Point 

Step 2 Depending on your choice in Step 1, specify the required destination information or select the path trace 
endpoint. 

The Cisco PathTracer window appears, displaying the resulting path trace.

Using a Pseudowire

To launch a path trace from a network pseudowire endpoint: 

Step 1 In the navigation pane or map pane, expand the required network pseudowire. 

Step 2 Right-click the required pseudowire endpoint and choose PathTracer > From Here to Destination. 

The Path Information dialog box is displayed as shown in Figure 12-7. 
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Figure 12-7 Path Information Dialog Box for a Network Pseudowire

Step 3 Specify the destination using the information in Table 12-4. 

Step 4 To limit the number of hops for the path trace, check the Stop trace after check box, and enter the 
maximum number of hops for the path trace.

The Cisco PathTracer window appears, displaying the resulting path trace.

Using an MPLS-TP Tunnel Endpoint

To launch a path trace from an MPLS-TP tunnel endpoint: 

Step 1 In the navigation pane or map pane, expand the required MPLS-TP tunnel. 

Step 2 Right-click the required MPLS-TP tunnel endpoint and choose PathTracer > From Here to 
Destination. 

The Path Information dialog box is displayed as shown in Figure 12-8. 
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Figure 12-8 MPLS-TP Tunnel Endpoint Path Trace Launch

Step 3 Specify the destination using the information in Table 12-4. 

Step 4 To limit the number of hops for the path trace, check the Stop trace after check box, and enter the 
maximum number of hops for the path trace.

The Cisco PathTracer window appears, displaying the resulting path trace.

Viewing Path Traces in Cisco PathTracer
The Cisco PathTracer window displays all discovered paths for the specified source and destination of 
the path trace, including the devices and physical links. 

In addition, the Cisco PathTracer window enables you to:

• Zoom in and out on path traces by using your mouse scroll wheel.

• Apply one of four icon sizes to icons.

• View more or less information about the element by resizing the icon. 

• Access common functions from the icons, such as attaching business tags or viewing properties. 

You can also right-click elements in the Cisco PathTracer window and choose options from a right-click 
menu. The right-click menu is context sensitive depending on the view and the item selected. For more 
information about the right-click menu and the available options, see Right-Click Menu Options, 
page 12-19.
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The Cisco PathTracer window enables you to:

• View multiple paths for a selected source and destination either sequentially or simultaneously.

• View individual paths with networking layer details.

• Save a map with multiple paths to a file.

• Run Cisco PathTracer again, using the same trace or with a different limit number of hops.

Figure 12-9 shows an example of the Cisco PathTracer window with a multiple-path trace.

Figure 12-9 Cisco PathTracer Window - Multiple-Path Trace

The Cisco PathTracer window contains the following components and options:

• Menus, page 12-16

• Toolbar, page 12-17

• Trace Tabs, page 12-18

• Paths Pane, page 12-18

1 Menu bar 4 Paths pane

2 Toolbar 5 Status bar

3 Trace tabs 6 Path trace pane
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• Path Trace Pane, page 12-18

• Right-Click Menu Options, page 12-19

Menus
Table 12-5 describes the options available in the Cisco PathTracer menus.

Table 12-5 Cisco PathTracer Window Menu Options

Option Description

File Menu

Run Again Offers the following options for running Cisco PathTracer again for the same 
source and destination: 

• Change Hop Count—Enables you to enter a new hop count. 

• Repeat Last Trace—Runs the previous trace with the same settings. 

• Run Full Path Trace—Runs the previous trace without a hop count limit.

Save Opens the Save dialog box so that you can save the current path trace to your 
local system in XML format.

Close Closes the Cisco PathTracer window.

Edit Menu

Select All Selects all paths in the selected path trace pane.

View Menu

Layout Specifies how the elements are arranged in the path trace pane: circular, 
hierarchical, orthogonal, or symmetric.

Overview Opens a window displaying an overview of the path trace.

Zoom In Zooms in on the current path trace.

Zoom Out Zooms out on the current path trace.

Fit in Window Fits the entire path trace in the path trace pane.

Normal Select Activates the normal selection mode.

Pan Activates the pan mode, which enables you to move around in the path trace by 
clicking and dragging.

Zoom Selection Enables you to zoom in on a specific area in the path trace. 
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Toolbar
Table 12-6 describes the options available in the Cisco PathTracer toolbar. 

Table 12-6 Cisco PathTracer Toolbar Options

Button Function

Displays the previous path in the path trace pane.

Displays the next path in the path trace pane.

Clears the path selection made in the path trace pane.

Opens the Cisco PathTracer details window. A map is displayed for the selected path, 
including network element details, links, and property information. For more information, 
see Viewing Path Trace Details, page 12-20.

Saves the current multiple-path trace to an XML file on your local system. For more 
information, see Saving and Opening Cisco PathTracer Map Files, page 12-26.

Offers the following options for running Cisco PathTracer again for the same source and 
destination:

• Change Hop Count—Enables you to enter a new hop count. 

• Repeat Last Trace—Runs the previous trace with the same settings. 

• Run Full Path Trace—Runs the previous trace without a hop count limit.

The new path trace map is displayed in the path trace pane. 

A new tab with the up-to-date (or refreshed) path map is created for each run, with each tab 
representing a run and the tab label indicating the snapshot time.

Opens a window displaying a high level view of the path trace currently displayed in the 
path trace pane.

Specifies how the elements are arranged in the path trace pane: circular, hierarchical, 
orthogonal, or symmetric.

Fits the entire path trace in the path trace pane.

Activates the normal selection mode. The button toggles when selected or deselected.

Activates the zoom selection mode, which enables you to select a specific area in the path 
to zoom in on by clicking and dragging. The button toggles when selected or deselected.

Activates the pan mode, which enables you to move around in the path trace by clicking and 
dragging. The button toggles when selected or deselected.
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Trace Tabs
The discovered path trace is initially displayed in the path trace pane with a tab that displays the date 
and time when Prime Network started the path tracing process (snapshot time). 

If you load a saved path from a file or run the displayed path trace again, the opened or refreshed path 
is displayed in a new tab with a refreshed path map for each run or file. When using a saved path from 
a file, the source and destination must be the same as the current display for it to appear in the same path 
trace window. Each tab represents a run or file, and its header displays the snapshot time.

Paths Pane
The paths pane lists all the paths discovered in the current path trace. A new path is created for each 
source and destination pair. The paths are identified by number, such as 1, 2, and 3. 

If you launch a path trace with a specific hop count, the paths pane displays First n Hops where n is the 
number of hops specified. 

Selecting a path in the paths pane highlights the selected path in the path trace pane. The paths that are 
not selected are dimmed in the map. 

To view a different path, do either of the following: 

• Choose a different path in the paths pane.

• Click Select Previous Path or Select Next Path in the toolbar.

To remove a path selection, click Clear Path Selection in the toolbar.

Path Trace Pane
The path trace pane displays the devices, links, and topological paths that are part of the path trace. All 
links and nodes in the path trace pane are labeled with their relevant path numbers, corresponding to the 
numbers in the paths pane. The starting point is labeled with a Starting Point callout. All other edge 
points are displayed as clouds.

The same coloring conventions that are used for links in the Prime Network content pane are used to 
display links in the Cisco PathTracer path trace pane. 

Cisco PathTracer uses icons to display the network objects and their status. The status of a network 
object can be indicated on the topological map in the following ways:

• Severity

• Management state

• New alarms 

For more information, see:

• Prime Network Vision Status Indicators, page 2-16

• Chapter 2, “Working with the Cisco Prime Network Vision Client”

• Map View, page 2-7
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Right-Click Menu Options
You can right-click network elements in the path trace window and choose items from a right-click 
menu. The right-click menu is context sensitive depending on the view and the element selected. 

Table 12-7 describes the right-click menu options that are available for elements selected in the 
Cisco PathTracer window.

Table 12-7 Cisco PathTracer Element Right-Click Menu Options

Option Description

Inventory Opens the inventory window for the selected element.

Aggregate Groups the selected devices into an aggregation. 

Disaggregate Ungroups the devices in the selected aggregation. 

Note This option is available only when an aggregation is selected.

Poll Now Polls the selected element.

Attach Business Tag Attaches a business tag to the selected network element

Config Mgmnt Displays the Configuration Management page for the selected device in 
Prime Network Change and Configuration Management. For more 
information, see Chapter 4, “Device Configurations and Software Images.”

Image Mgmnt Displays the Configuration Management page for the selected device in 
Prime Network Change and Configuration Management. For more 
information, see Chapter 4, “Device Configurations and Software Images.”

Resize Enables you to resize an object on the map by percentage or size.

Open Relevant Maps Displays the Open Map dialog box so that you can view and open maps that 
contain the selected element. 

Run Report Enables you to run standard or user-defined events, inventory, and network 
service reports on demand. 

Show Callouts/ 
Hide Callouts

Displays or hides callouts associated with the selected element.

Tools Contains the following choices:

• CPU Usage—Displays memory and CPU usage information for a device 
or network element.

• Ping—Pings the device from the client station.

• Telnet—Communicates with the device using the Telnet window from 
the client station.

Note If you use a Windows 7 system, you must enable the Windows Telnet 
Client before you can use the Prime Network Vision Telnet option.

- For Windows 7 32-bit systems, enable the Windows Telnet Client 
to use the Prime Network Vision Telnet option. 

- For Windows 7 64-bit systems, a solution is available on the 
Cisco Developer Network at 
http://developer.cisco.com/web/prime-network/forums/-/message_b
oards/message/2780108. 
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Viewing Path Trace Details 
In addition to the information displayed in the Cisco PathTracer window, you can: 

• View the following information for each network element:

– The relevant parameters for each interface on all layers along the path.

– For each layer, an indication of a mismatch between the parameters of the interfaces on both 
sides of a link.

– Traffic statistics along the path.

• Monitor the status and traffic of all links along the path.

• View In and Out port properties. 

To view this information, select the required path in the Cisco PathTracer window, and then click 
PathTracer in the toolbar. If you select multiple paths, a separate window is opened for each path.

Figure 12-10 shows an example of the Cisco PathTracer details window. 

Topology Enables you to add:

• A static link between two devices.

• A static topology between a device and an unmanaged network.

• A tunnel to a VPN. 

Launch external 
applications

Starts an external application or tool that has been configured for access via 
the right-click menu. For more information, see the Cisco Prime Network 
3.10 Customization Guide. 

Properties Displays the properties of the selected item, such as the IP address and 
system name. 

Commands Launches available activation and configuration scripts. This can include the 
commands documented in , page 3-36, and those you create using Command 
Builder. For more information, see the Cisco Prime Network 3.10 
Customization Guide. 

Management Contains the following submenu options:

• Command Builder—Defines commands and scripts using the Prime 
Network Command Builder tool (Configurator security level required).

• Soft Properties Management—Extends VNEs by adding SNMP MIB or 
Telnet/SHH/TL-1 properties to the device’s collected information model 
using the Prime Network Soft Properties Manager (Administrator 
security level required). 

VNE Tools Contains the following submenu options:

• Poll Now—Updates the VNE information.

• Stop VNE—Stops the VNE.

• Start VNE—Starts the VNE. 

Table 12-7 Cisco PathTracer Element Right-Click Menu Options (continued)

Option Description
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Figure 12-10 Cisco PathTracer Details Window

The Cisco PathTracer details window contains the following components:

• Menus, page 12-22

• Cisco PathTracer Details Window Toolbar, page 12-22

• Path Trace Pane, page 12-23

• Details Pane, page 12-25

1 Menu bar 5 Details pane

2 Toolbar 6 Layer and Business tabs

3 Path trace pane 7 Status bar

4 Hide/display path trace pane
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Menus
Table 12-8 describes the Cisco PathTracer details window menu options.

Cisco PathTracer Details Window Toolbar
Table 12-9 describes the tools that are available in the Cisco PathTracer details window toolbar.

Table 12-8 Cisco PathTracer Details Window Menus

Option Description

File Menu

Close Closes the Cisco PathTracer window.

View Menu

Show All Displays all the information in the tabs.

Hide All Hides all the information in the tabs.

Tools Menu

Export to File Exports the currently displayed data to a CSV file.

Start Saving to File Starts exporting the counter values of the path displayed in the 
Cisco PathTracer window to a CSV file.

Stop Saving to File Stops exporting the counter values of the path displayed in the 
Cisco PathTracer window to a CSV file.

Help Menu

Help Contents Opens the online help for Cisco Prime Network Vision and 
Cisco Prime Network Events. 

Help About Displays the Cisco Prime Network Vision version and any 
additionally installed applications. 

Table 12-9 Cisco PathTracer Details Window Toolbar Options

Button Name Function

Show All Displays all the information in the tabs.

Hide All Hides all the information in the tabs.

Export to File Exports the currently displayed data to a CSV file.

Start Saving to File Starts exporting the counter values of the path displayed in the 
Cisco PathTracer window to a CSV file.

Stop Saving to File Stops exporting the counter values of the path displayed in the 
Cisco PathTracer window to a CSV file.
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Path Trace Pane
The path trace pane in the Cisco PathTracer details window displays information related to the tab 
selected in the details pane. For example, if you choose the Layer 2 tab in the details pane, Layer 2 
information is displayed in the path trace pane. Similarly, if you choose an element or link in the path 
trace pane, the related parameters are highlighted in the details pane. 

By default, the path trace pane includes:

• Edge points

• Elements included in the path trace, including badges

• Links included in the path trace

Hovering your mouse over an element displays a tooltip that contains the element name, device type, and 
IP address. Hovering your mouse over the link to the right or left of the element displays the associated 
incoming or outgoing interface for that element and link. 

Table 12-10 describes the right-click menu options that are available for elements in the path trace pane. 

Table 12-10 Cisco PathTracer Element Right-Click Menu Options

Option Description

Inventory Opens the inventory window for the selected element.

Attach Business Tag Attaches a business tag to the selected network element

Poll Now Polls the selected element.

Config Mgmnt Displays the Configuration Management page for the selected 
device in Prime Network Change and Configuration Management. 
For more information, see Chapter 4, “Device Configurations and 
Software Images.”

Image Mgmnt Displays the Configuration Management page for the selected 
device in Prime Network Change and Configuration Management. 
For more information, see Chapter 4, “Device Configurations and 
Software Images.”

Run Report Enables you to run standard or user-defined events, inventory, and 
network service reports on demand. 
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Tools Contains the following choices:

• CPU Usage—Displays memory and CPU usage information for 
a device or network element.

• Ping—Pings the device from the client station.

• Telnet—Communicates with the device using the Telnet 
window from the client station.

Note If you use a Windows 7 system, you must enable the 
Windows Telnet Client before you can use the Prime 
Network Vision Telnet option.

- For Windows 7 32-bit systems, enable the Windows Telnet 
Client to use the Prime Network Vision Telnet option. 

- For Windows 7 64-bit systems, a solution is available on 
the Cisco Developer Network at 
http://developer.cisco.com/web/prime-network/forums/-/m
essage_boards/message/2780108. 

Topology Enables you to add:

• A static link between two devices.

• A static topology between a device and an unmanaged network.

• A tunnel to a VPN. 

Launch external 
applications

Starts an external application or tool that has been configured for 
access via the right-click menu. For more information, see the 
Cisco Prime Network 3.10 Customization Guide. 

Properties Displays the properties of the selected item, such as the IP address 
and system name. 

Commands Launches available activation and configuration scripts. This can 
include the commands documented in Configure Basic Device 
Settings: Name, DNS, NTP, RADIUS, TACACs, ACLs, page 1-4, 
and those you create using Command Builder. For more 
information, see the Cisco Prime Network 3.10 Customization 
Guide. 

Table 12-10 Cisco PathTracer Element Right-Click Menu Options (continued)

Option Description
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Details Pane
Selecting a device or link in the path trace pane automatically highlights the related parameters in the 
details pane.

The details pane, with its Layer and Business tabs, displays the supported parameters of the selected 
element in a table, with the ingress and egress ports along the top and the parameters on the left.

Any inconsistencies between the two connected ports are colored to emphasize a discrepancy, such as 
different admin statuses.

The information parameters are arranged as follows:

• Layer n tabs—These tabs provide information about each network element, including ingress and 
egress port information. The information is either plain data that is extracted from the element or 
calculated data, such as rates or statistics. This information is displayed in the Layer 1, Layer 2, and 
Layer 3 tabs, as follows: 

– Layer 1—Displays the Layer 1 information in the selected path and enables you to view the link 
parameters. The name of each device is displayed, as well as the subslot, slot, and port details. 

– Layer 2—Displays the Layer 2 information in the selected path and enables you to view the link 
and connection parameters. For each device, the name and MAC address are displayed, as well 
as the VPI/VCI in an ATM link or the DLCI in a Frame Relay link. By default, the 
Cisco PathTracer details window is displayed with the Layer 2 tab active. 

– Layer 3—Displays the Layer 3 information in the selected path and enables you to view the link 
parameters. The name of each device is displayed.

If a field has no value on any of the interfaces, the field is not displayed in the table. For example, 
if none of the interfaces is configured for MTU, the MTU row is not displayed in the table. If at least 
one of the interfaces is configured for MTU, the MTU row is displayed.

• Business tab—This tab provides the name and key of business tags that are attached to the network 
entities displayed, including ports, devices (physical entities), VCIs, VPIs, DLCIs, contexts (logical 
entities), or MPLS. This information is displayed in the Business Tag area.

Management Contains the following submenu options:

• Command Builder—Defines commands and scripts using the 
Prime Network Command Builder tool (Configurator security 
level required).

• Soft Properties Management—Extends VNEs by adding SNMP 
MIB or Telnet/SHH/TL-1 properties to the device's collected 
information model using the Prime Network Soft Properties 
Manager (Administrator security level required). 

VNE Tools Contains the following submenu options:

• Poll Now—Updates the VNE information.

• Stop VNE—Stops the VNE.

• Start VNE—Starts the VNE. 

Table 12-10 Cisco PathTracer Element Right-Click Menu Options (continued)

Option Description
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Saving and Opening Cisco PathTracer Map Files
Prime Network enables you to export multiple-path trace maps that are displayed in the Cisco PathTracer 
window to an XML file. You can view the data later to assess whether anything has changed.

Saving Cisco PathTracer Map Files

To save Cisco PathTracer map files:

Step 1 Open the Cisco PathTracer window as described in Launching Path Tracer, page 12-3.

Step 2 Click Save MultiPath in the toolbar.

Step 3 In the Save dialog box, navigate to the directory where you want to save the file and enter a name for the 
map file.

Step 4 Click Save. The map file is saved in the selected directory.

Opening Cisco PathTracer Map Files

Prime Network enables you to open saved XML-formatted path-tracing maps.

The following conditions apply when working with multiple-path trace files: 

• When you load a multiple-path trace file, Prime Network queries the file (not the network), and 
loads the persisted information. 

• If you load a multiple-path trace file that does not contain the same start and end points, the map is 
automatically opened in a new Cisco PathTracer window.

To open Cisco PathTracer map files:

Step 1 In Cisco Prime Network Vision, choose File > Load MultiPath from the main menu. The Open dialog 
box is displayed.

Step 2 Navigate to the directory of the saved file and select the file.

Step 3 Click Open. The previously saved map is displayed in the Cisco PathTracer window.

Saving Cisco PathTracer Counter Values
Prime Network enables you to export, over a period of time, the counter values of the path displayed in 
the Cisco PathTracer window to a CSV file. The data can then be viewed later, as required.

Note This topic applies to the Cisco PathTracer details window only.

To save Cisco PathTracer counter values that are generated over a period of time: 

Step 1 Open the Cisco PathTracer details window as described in Viewing Path Trace Details, page 12-20. 

Step 2 Click Start Saving to File in the toolbar.
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Step 3 In the Export Table to File dialog box, navigate to the directory where you want to save the 
Cisco PathTracer counter values. 

Step 4 In the File name field, enter a name for the file in which to save the counter values.

Step 5 Click Save. Cisco PathTracer starts saving the counter values to the specified file.

Step 6 To stop exporting counter values to the file, click Stop Saving to File in the toolbar.

Cisco PathTracer stops exporting the counter values to the file.

Rerunning a Path and Comparing Results
If you save a path to a file (see Saving and Opening Cisco PathTracer Map Files, page 12-26), you can 
use the file to rerun the same path automatically with the same source and destination. You can also 
compare the saved path to a newly run path to determine if the path has changed or to assess a problem. 

To rerun a saved path: 

Step 1 Load the required map file as described in Saving and Opening Cisco PathTracer Map Files, page 12-26. 
The Cisco PathTracer window is displayed with the previously saved map file.

Step 2 Click Run Again in the toolbar.

The path trace runs automatically using the same source and destination as the loaded map file, and a 
new tab is displayed in the Cisco PathTracer window with the updated map. The tab displays the date 
and time when the path was rerun.

Step 3 Compare the previous map to the updated one by switching between the tabs in the Cisco PathTracer 
window.

Note • If you load a Cisco PathTracer map file that does not contain the same source and destination 
information as the map that is currently displayed in the window, the map is automatically opened 
in a new Cisco PathTracer window.

• If you load a Cisco PathTracer map file that contains the same source and destination information 
as a map that is currently displayed in the window, the map is loaded in a new tab in the same 
window.

Viewing Q-in-Q Path Information 
The Q-in-Q (IEEE 802.1) tagging technology (also known as Dot1q tunneling) allows the nesting of 
another VLAN tag in a packet, in addition to an existing one. Either VLAN tag is considered an 802.1Q 
header.
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Cisco PathTracer uses the VLAN tags of the Ethernet header and the port configuration to trace the path 
from one interface to another over the network. Among other things, you can:

• View a Layer 2 path across a LAN domain with all the VLAN tag information.

• For each network element, view the relevant parameters for each interface on all layers along the 
path.

Q-in-Q and Dot1q information is displayed in the Cisco PathTracer window when a path is traced over 
Ethernet ports with Dot1q and a Q-in-Q configuration.

As described in Launching Path Tracer, page 12-3, to view a specific path, you must specify an initial 
start point, such as an IP interface, and then an endpoint, such as a destination IP address. 

To trace a Q-in-Q path, you start the path from any:

• Router or switch that is part of the Ethernet domain with Dot1q and Q-in-Q configurations.

• IP destination that can be reached from that point of the network.

After you select the endpoint, the Cisco PathTracer window is displayed. From this window, you can 
open the Cisco PathTracer details window, with the appropriate Q-in-Q information displayed in the 
Layer 2 tab. 

The Layer 2 tab can display the following information specific to Q-in-Q and VLAN port configurations:

• VLAN Mode—The work mode for the interface: Unknown, Access, Trunk, or Dot1Q Tunnel. Trunk 
mode also refers to multiple tagging.

• Native VLAN ID—The VLAN identifier that is used to tag untagged traffic received on a trunked 
interface: 

– If VLAN tagging is enabled, the default native VLAN identifier is 1.

– If VLAN tagging is disabled, the native VLAN identifier is 0 (zero) or “no VLAN ID.” 

• CE VLAN ID—The customer edge device VLAN identifier.

• SP VLAN ID—The service provider VLAN identifier.

Viewing L2TP Path Information
Cisco PathTracer uses VC ID encapsulation information to trace the path from one tunnel interface to 
another over the network. The Cisco PathTracer tool enables you to:

• View a path for the defined Layer 2 Tunneling Protocol (L2TP) session across the network.

• For each network element, view the relevant parameters for each interface on all layers along the 
path.

The Layer 3 tab displays the peer name for L2TP tunnels. 

Table 12-11 describes the information that is displayed in the Layer 2 tab for L2TP tunnels. 

Table 12-11 Layer 2 Tab Information for L2TP Tunnels

Field Description

Encapsulation Type Encapsulation type, such as Point-to-Point Protocol over ATM (PPPoA).

Binding Information Name of the subscriber.

Binding Status Binding status: bound or unbound.

Tunnel Session Count Number of current sessions.
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Using Cisco PathTracer in MPLS Networks
You can open and view Cisco PathTracer information between service endpoints, such as an IP interface 
that is attached to the VRF over an MPLS network. The LSP in the MPLS network is found according 
to the cross-connect table of each router.

Note An LSP can be traced and displayed by Cisco PathTracer as part of an end-to-end tracing of a service; 
for example, when viewing a path between one CE device and another. Cisco PathTracer traces the path 
that goes over circuits or VLANs in the access networks. It also traces the LSPs between the VRFs going 
through all intermediate devices such as CE devices, aggregation switches, PE routers, and core routers.

To view a specific path, you must specify an initial starting point, such as an IP interface; specifying a 
destination IP address is optional. If the traced path (for example, a VC or VLAN) ends in a router, 
Cisco PathTracer finds the next hop according to the destination IP address. If you select an endpoint, 
Cisco PathTracer extracts the relevant IP address from this point and uses it as the destination.

The following topics provide more information on using Cisco PathTracer in MPLS networks: 

• Cisco PathTracer MPLS Start and Endpoints, page 12-30

• Using Cisco PathTracer for CSC Configurations, page 12-31

• Using Cisco PathTracer for Layer 3 VPNs, page 12-32

• Using Cisco PathTracer for Layer 2 VPNs, page 12-32

• Using Cisco PathTracer for MPLS TE Tunnels, page 12-33

Tunnel Remote ID Remote tunnel identifier.

Tunnel ID Local tunnel identifier.

Tunnel Name Name of the subscriber and the tunnel identifier.

Session ID Session identifier.

Traffic > L2TPSession
Counters

Number of traffic packets passing through the L2TP tunnel.

Traffic < 
L2TPSessionCounters

Number of traffic packets passing through the L2TP tunnel.

Tunnel Ctl Errors Number of control errors.

Tunnel State Tunnel state: unknown, idle, connecting, established, or disconnecting.

Session Type Session type: unknown, LAC, or LNS.

Peer Name Peer name.

Tunnel Remote IP Remote IP address of the tunnel.

Last Error Code Value of the last error code that caused the tunnel disconnection.

Session State Session state: unknown, idle, connecting, established, or disconnecting.

Remote Session ID Remote session identifier.

Table 12-11 Layer 2 Tab Information for L2TP Tunnels (continued)

Field Description
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Cisco PathTracer MPLS Start and Endpoints
You can open Cisco PathTracer by right-clicking a starting point and entering the required destination 
IP address. Table 12-12 lists the Cisco PathTracer starting points.

If you choose the Start Here option, Table 12-13 lists the endpoints that can be selected as path 
destinations.

The Cisco PathTracer window is displayed. From this window you can open the Cisco PathTracer details 
window with the VPN information displayed in the Layer 2 and Layer 3 tabs. 

Note If multiple paths are selected in the paths pane, or if nothing is selected in the paths pane, all available 
paths are opened automatically, and each is displayed in a separate Cisco PathTracer window.

Table 12-12 Cisco PathTracer MPLS Starting Points

Element Location Start Options

IP interface • Inventory window

• Affected entity (enabled only if the 
affected entity has an IP interface)

• From Here to Destination

• Start Here

MPLS-TP tunnel 
endpoint

• Navigation or map pane

• Inventory window

• From Here to Destination

• Start Here

Site Service view map • From Here to Destination

• To Subnet Destination

• Start Here

Business tag 
attached to the 
VPI/VCI or IP 
interface 

The path can be found using a business tag, 
which is attached to the VPI/VCI or IP 
interface by entering its key. It can then be 
opened from the Find Business Tag window.

From Here to Destination

Layer 2 MPLS 
Tunnel

Inventory window From Here to Destination

Table 12-13 Cisco PathTracer MPLS Endpoints

Element Location End Options

IP interface • Inventory window

• Affected entity (enabled only if the 
affected entity has an IP interface)

End Here

MPLS-TP tunnel 
endpoint

Inventory window End Here

Site Service view map End Here
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Using Cisco PathTracer for CSC Configurations
Cisco PathTracer traces a CSC flow from the customer CE through the customer carrier VPN, across the 
customer backbone carrier VPN, back to the customer carrier VPN, and to the destination CE. 

To launch a path trace for a CSC configuration: 

Step 1 In a map, double-click the required CE device.

Step 2 In the inventory window, choose Logical Inventory > Routing Entities > Routing Entity. 

Step 3 In the IP Interfaces table, right-click the required interface and choose PathTracer > Start Here > IPvn 
where IPvn represents IPv4 or IPv6. 

Step 4 Navigate to the destination CE device and double-click it.

Step 5 In the inventory window, choose Logical Inventory > Routing Entities > Routing Entity. 

Step 6 In the IP Interfaces table, right-click the required interface and choose PathTracer > End Here. 

The path trace is displayed in the Cisco PathTracer window.

Step 7 To view the detailed pane, click Cisco PathTracer in the toolbar. 

The Layer 2 tab displays a single outer label and two inner labels for each interface, reflecting the CSC 
configuration. (See Figure 12-11.) 

Figure 12-11 CSC Configuration Path Trace
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Using Cisco PathTracer for Layer 3 VPNs
Cisco PathTracer uses VRF routing and label switching information to trace the path from one VRF 
interface to another. If you choose a launch point and destination from the right-click menu, you can 
open the Cisco PathTracer for Layer 3 VPNs. The Cisco PathTracer window shows the VPN topology 
map. From this window, you can open the Cisco PathTracer details window with the appropriate VPN 
information displayed in the Layer 2 and Layer 3 tabs. 

For Layer 3 path information, Prime Network uses VRF routing and label switching information to trace 
the path from one VRF interface to another. Layer 3 path trace information is displayed in the 
Cisco PathTracer window when the path goes over connections and ends in VRFs. 

If a VRF table includes more than one path toward a destination, Cisco PathTracer shows all paths.

To view Layer 3 path information, choose the Layer 3 tab and choose Show All from the View menu. 
The path information is displayed in the active tab.

The table displays the Layer 3 VPN information on the device that has a VRF. The following Layer 3 
properties displayed in the Layer 3 tab relate specifically to VPNs:

• Name—The name of the site. For example, ATM4/0.100(10.0.0.1) is a combination of the interface 
name and IP address used to reach the site. Each site belongs to a particular VPN, so the address 
must be unique within the VPN.

• IP Address—The IP address of the interface.

• Mask—The mask of the specific network.

• State—The state of the interface (up or down).

• VRF Name—The name of the VRF.

Cisco PathTracer does not display or trace EXP bits for Layer 3 VPNs that use policy-based tunnel 
selection (PBTS). 

Using Cisco PathTracer for Layer 2 VPNs
Cisco PathTracer uses VC ID and label switching information to trace the path from one tunnel interface 
to another over the MPLS network.

Cisco PathTracer also covers end-to-end Layer 2 VPN service paths from one CE router to another. The 
path goes over circuits (such as a VC) or VLANs in access networks and over LSP between the Layer 2 
tunnel edge.

The Cisco PathTracer window shows the VPN topology map for the relevant devices and links. From this 
window, you can open the Cisco PathTracer details window with the appropriate VPN information 
displayed in the Layer 2 and Layer 3 tabs. 

For Layer 2 path information, Cisco PathTracer uses VC ID and label switching information to trace the 
path from one tunnel interface to another. Layer 2 path trace information is displayed in the 
Cisco PathTracer window when the path goes over pseudowire tunnels.

To view Layer 2 path information, choose the Layer 2 tab and then View > Show All. The path 
information is displayed in the active tab.
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Table 12-14 describes the Layer 2 properties that can be displayed in the Layer 2 tab specifically for 
VPNs.

Using Cisco PathTracer for MPLS TE Tunnels
Cisco PathTracer uses label switching information to trace the end-to-end path of a TE tunnel path from 
one PE router to another.

Using MPLS TE technology, Cisco PathTracer enables you to:

• View a path or list of devices.

• View the following information for each network element:

– The relevant parameters for each interface on all layers along the path.

– The path for the defined MPLS TE-LSP across the network.

The Cisco PathTracer window is displayed showing the MPLS TE tunnel topology map. From this 
window, you can open the Cisco PathTracer details window with the appropriate MPLS TE tunnel 
information displayed in the Layer 2 tab.

Note Cisco PathTracer does not display or trace EXP bits for Layer 3 VPNs that use PBTS. 

Table 12-14 Cisco PathTracer Layer 2 Properties for VPNs

Field Description

Top Label Details of the outer MPLS label.

Label Stack Details of the inner MPLS label.

MAC Address MAC address.

Tunnel ID Tunnel identifier. The identifier and the router IP address of the two 
tunnel edges identify the pseudowire tunnel.

Tunnel Type Tunnel type: 

• 0—Unknown

• 1—PWE3

• 2—TE

Tunnel Status Operational state of the tunnel: Up or Down.

Tunnel Local VC Label MPLS label that is used by the router to identify or access the tunnel. It 
is inserted in the MPLS label stack by the local router.

Tunnel Peer VC Label MPLS label that is used by the router to identify or access the tunnel. It 
is inserted in the MPLS label stack by the peer router.

Tunnel Local Router IP IP address of the tunnel edge, which is used as the MPLS router 
identifier.

Tunnel Peer Router IP IP address of the peer tunnel edge, which is used as the MPLS router 
identifier.

Distribution Protocol 
Type

Protocol used by MPLS to build the tunnel, such as LDP or TDP.

Peer OID Tunnel identifier and device name.
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Layer 2 and Layer 3 path trace information is displayed in the Cisco PathTracer details window when a 
path is traced over MPLS TE tunnels. To view Layer 2 path information, choose the Layer 2 tab and then 
View > Show All. The path information is displayed in the active tab.

Table 12-15 describes the Layer 2 properties that can be displayed in the Layer 2 tab specifically for 
MPLS TE tunnels. 

Table 12-15 Cisco PathTracer Layer 2 Properties for MPLS TE Tunnels

Field Description

MPLS TE Properties MPLS TE data set in an MPLS interface, primarily bandwidth allocation 
levels and signaling protocol.

Tunnel Oper Status Operational status of the tunnel: Up or Down. 

If this value is Up, the Tunnel Admin Status must also be Up. See Tunnel 
Admin Status properties for additional information. 

Tunnel Bandwidth Kbps Configured bandwidth (in Kb/s) for the tunnel. 

Tunnel Description Description of the tunnel.

Tunnel Name Interface name.

Tunnel Admin Status Administrative status of the tunnel (Up or Down) with the following 
caveats:

• If the Tunnel Oper Status value is Up, the Tunnel Admin Status 
value must also be Up. 

• If the Tunnel Admin Status value is Down, the Tunnel Oper Status 
value must also be Down.

Tunnel Lockdown Whether or not the tunnel can be rerouted:

• Enabled—The tunnel cannot be rerouted.

• Disabled—The tunnel can be rerouted.

Tunnel LSP ID LSP identifier. 

Tunnel Auto Route Whether or not destinations behind the tunnel are routed through the 
tunnel: Enabled or disabled.

Tunnel Hold Priority Tunnel priority after path setup. 

Tunnel Setup Priority Tunnel priority upon path setup.

Tunnel Path Option Tunnel path option:

• Dynamic—The tunnel is routed along the ordinary routing 
decisions after taking into account the tunnel constraints such as 
attributes, priority, and bandwidth. 

• Explicit—The route is explicitly mapped with the included and 
excluded links.

Tunnel Out Label TE tunnel MPLS label distinguishing the LSP selection in the adjacent 
device.

Tunnel Affinity Tunnel’s preferential bits for specific links.

Tunnel Destination Address IP address of the device in which the tunnel ends.

Tunnel Peak Rate Kbps Peak flow specification (in Kb/s) for this tunnel.

Tunnel Out Interface Interface through which the tunnel exits the device.
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Tunnel Burst Kbps Burst flow specification (in Kb/s) for this tunnel.

Tunnel Average Rate Kbps Tunnel average rate in Kb/s.

Tunnel Affinity Mask Tunnel affinity bits that should be compared to the link attribute bits.

Table 12-15 Cisco PathTracer Layer 2 Properties for MPLS TE Tunnels (continued)

Field Description
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